
Virtuális Instrumentáció LabVIEW-el



A tanfolyam céljai

• A virtuális műszer (VI) elemeinek megismerése
• LabVIEW bevezetés és a főbb LabVIEW függvények
• Egy egyszerű adatgyűjtő alkalmazás elkészítése
• Szubrutin készítése LabVIEW-ben
• Vektor, Klaszter és Struktúra használata
• Nyomtatás és dokumentációs sajátságok 
• Fejlesztés a fontosabb programozási architektúrákban
• VI közzététele a világhálón



I. rész

• A LabVIEW nyelvezete
• Egy LabVIEW alkalmazás elemei
• A LabVIEW programozás eszközei
• Egy LabVIEW alkalmazás elkészítése



Előlap
• Kontrol = Bemenet
• Indikátor = Kimenet

Blokk Diagramm
• Az előlaphoz kapcsolódó 

“program”
• Komponensek össze 

“huzalozása” 

A LabVIEW Program neve Virtuális Műszer (VI)



VI Előlap (Front Panel)
Előlapi 
eszköztár

Jel
magyarázat

Logikai
Kontrol
(Boolean)

Hullámforma
grafikon

Ikon

Tengely
magyarázat

Skála
eszközök
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Express VI-ok, VI-ok és függvények
• Express VI: interaktív VI konfiguráló dialógussal
• VI: moduláris VI, huzalozással konfigurálható
• Függvény: alapvető építőelem a LabVIEW-ben; 

nincs sem előlapja sem blokkdiagramja

Express VIExpress VI hagyományoshagyományos VIVI

FFüggvényüggvény



Kontrol és Függvény Paletták

Kontrol Paletta
(Előlapi ablak)

Függvény Paletta
(Blokkdiagram ablak)



Működtető eszköz

Pozícionáló/Átméretező

Címke/Felirat eszköz

Huzalozó

Gyorsmenű eszköz

• Lebegő Paletta
• Az előlapi és a blokkdiagram 

objektumok létrehozására, 
működtetésére és módosítására való.

Scroll eszköz

Megszakítási pont 

Próba pont

Színmásoló

Szinező

Eszközök Paletta

Automatikus eszköz választás



Futtatás gomb

Ismételt futtatás

Végrehajtás leállítása

Leállítás/Folytatás

Szöveg beállításai

Objektumok igazítása

Objektumok rendezése

Sorrend, csoportosítás

Előlapi elemek 
átméretezése

Végrehajtás 
nyomkövetése

Belépés egy blokkba

Blokk átugrása

Kilépés a blokkból

További gombol a 
Blokkdiagram eszköztáron

Eszköztár



Virtuális Mérőműszer megnyitása és futtatása
Példa kereső



Kontrol
terminálok

Blokk diagram ablak

Előlapi ablak

Indikátor 
terminálok

Virtuális mérőműszer létrehozása 



VI létrehozása – Blokk diagram



Huzalozási tippek – Blokk diagram
Huzaloz “forró pontja”

Vezetékezés tisztázásaAutomatikus 
útválasztás

Vezeték választás kattintással



• A blokkdiagram az 
adatáramlási sorrendben 
hajtódik vége; NEM jobbról 
balra (ami csak egy konvenció)

• Egy csomópont akkor hajtódik 
végre, ha minden adat elérhető 
a bemeneti terminálokon

• A csomópont futtása után 
adatokat szolgáltat a kimenetén

Adatfolyam programozás



A súgó lehetőségei

Tartalomfüggő Súgó
• Segítség
• Oldal rögzítése
• Egyszerű/Bő diagram Súgó
• Ctrl + H

Referencia
• Minden menűpont, opció
• A gyorsmenüből közvetlenül isis elérhető minden függvényre



1. Gyakorlat 1 - konvertálás °C-ról °F-re

A bemenet 1.8A bemenet 1.8--al megszorozni, és hozzáadni 32al megszorozni, és hozzáadni 32--t!t!



Javítás - ellenőrzés módszerei
• Hibakeresés

• Végrehajtás nyomkövetése

• Ellenőrzés

A töredezett futtatásgomra kattintva
A hibát leíró ablak jelenik meg

A nyomkövetés gombra klikkelve; az 
adatáramlást buborékok mozgása jelzi. Az 
értékeke a vezetéken megjelennek.

Jobboldali egérgomb kattintásra a vezetéken 
megjelenik a próbaablak, amely kijelzi az 
áthaladó értéket

A próbapont az eszközpalettából is 
kiválasztható



II. rész – SubVI-ok

• Mi a subVI?
• Ikon és csatlakozó 

készítése
• VI használata subVI-ként



Blokk Diagram Csomópontok

Ikon Kiterjeszthető csomópont Kiterjesztett csomópont

• Függvény generátor VI
• egyazon VI, háromféle nézet
• A sárga mező hagyományos VI-t jelöl
• A kék mező Express VI-t jelöl



SubVIs
• Egy SubVI olyan VI amit egy másik VI-on belül 
használunk

• Hasonló, mint a szubrutin
• Előnyök

– Moduláris
– Egyszerűbb tesztelés
– Nem  kell újraírni a kódot
– Kevesebb memóriát igényel



Ikon és Csatlakozó

• Az ikon jelöli a VI-t egy másik 
diagrammban

• A csatlakozók mutatják az 
adatátvitelhez rendelkezésre álló 
pontokat

Icon

Connector

Terminals



SubVI-ok Sub VISub VI--okok



A SubVI létrehozásának lépései

• Ikon készítés
• Csatlakozó készítés
• Csatlakozók megfeleltetése
• A VI mentése
• A VI beillesztése a felső szintű VI-ba



Ikon létrehozása
• Dupla-kattintás az ikonra a 
diagramm vagy előlapi panelen



Csatlakozó létrehozása
Jobb-egérgombbal az előlapi panel ikonjára kattintva



Csatlakozók megfeleltetése



VI - mentése

• Válasszon egy könnyen megjegyezhető helyet
• Rendezés funkciók szerint

– Hasonló feladatú VI-ok egy könyvtárban (pl. Matematikai 
rutinok)

• Alkalmazás szerinti szervezés
– Minden VI-t ami az adott alkalmazáshoz tartozik egy 

könyvtárba, vagy könyvtárfileba tenni (pl. Lab 1 –
Frekvencia válasz)

• A könyvtárfile (.llbs) sok VI-t egy fileban táról, ideális pl. egy 
alkalmazás átvitelére egyik gépről a másikra



SubVI beillesztése a fő VI-ba
Saját subVI-ok elérése

Functions >>All Functions >> Select a VI
Vagy

Az ikon áthúzása a cél diagrammra



Tippek a LabVIEW-el való munkához

• Gyorsbillentyű kombinációk
– <Ctrl-H> – Aktiválja/Deaktiválja a súgó ablakot
– <Ctrl-B> – Eltávolítja a hiányos (Broken) vezetékeket
– <Ctrl-E> – Váltás az előlap és a diagram között
– <Ctrl-Z> – Mégse (az Edit menűben)

• Tools » Options… – LabVIEW preferenciák
• VI Properties – A VI megjelenése, Dokumentálása, 
stb.



III. rész – Adatgyűjtés

• Adatgyűjtés alapjai (DAQ) 
• Jelek bekötése
• Egyszerű DAQ alkalmazás

Computer

DAQ Device

Terminal Block

Cable

Sensors



Adatgyűjtés LabVIEW-ben

Hagyományos NI-DAQ
Egyedi VI-ok minden 
méréstípusra és 
feladatra:
• Analóg Input
• Analóg Output
• Digitális I/O
• Számláló műveletek

NI-DAQmx
Újabb generáció: 
• VI-ok a feladat szerint
• Egy VI készlet 
minden méréstípushoz



DAQ – Adatgyűjtés
Hőmérséklet mérés a DAQ segéd alkalmazásával



Adatgyűjtési terminológia Terminology

• Resolution – Felbontás: Hányféle feszültségszint 
különböztethető meg
– Nagyobb felbontás A jel pontosabb reprezentálása

• Range – Tartomány: Legkisebb és legnagyobb 
feszültség
– Kisebb tartomány A jel pontosabb reprezentálása

• Gain – Erősítés: A jel erősítése vagy gyengítése, hogy 
jobban illeszkedjen a tartományba



Hardware Csatlakozók

BNC-2120

SCB-68

NI-ELVIS

SC-2075



Gyakorlat 2 – Egyszerű adatgyűjtés
Celsius/Farenheit konverzió alkalmazásával a 

Thermometer.vi.



IV rész – Ciklusok és Grafikonok (Charts)

• For Ciklus 
• While Ciklus
• Charts - FutóGrafikon
• Többszörös grafikon



Ciklusok, Hurkok

• While Ciklus
– Van ciklusszámláló 

csatlakozója
– Legalább egyszer lefut
– Futás a feltétel szerint

• For Loops
– Van ciklusszámláló 

csatlakozója (0)
– Az N input számú 

végrehajtás



Ciklusok (folyt.)
1. Ciklus kiválasztása 2. Az ismételt kódrész körbezárása

3. További csomópontok behúzása a ciklusba, huzalozás



Charts

Hullámforma chart – speciális 
numerikus indikátor amely egy 
időbeli értéksort ábrázolhat

Controls >> Graph Indicators 
>>  Waveform Chart



Adatok huzalozása a Chart-hoz

Egy adatsor ábrázolása Több adatsor ábrázolása



3. Gyakorlat – Ciklusok használata
Véletlenszám generálás és 

kirajzolás lassíthatóan



V. rész – Tömbök & File I/O
• Manuális tömb építés
• Automatikus tömb generálás
• Táblázat kiírása fileba
• Táblázat beolvasása fileból



Tömb elhelyezése az előlapon
A Controls >> All Controls >> Array and Cluster
palettáról kiválasztjuk a Tömb keretet

Drop it on the screen.



Tömb létrehozása (folyt.)

Helyezzük a kívánt adatot a keretbe (p.l.
számkontrol)



Tömb generálása ciklussal

• A ciklus tömböt gyűjthet a peremén



2D Tömb generálása



File I/O
File I/O – adatok ki és bevitele file-ba
- A file lehet bináris, szöveg, vagy tábla
- Write/Read LabVIEW Measurements file (*.lvm)

LVM fileLVM file írásaírása LVM fileLVM file olvasásaolvasása



LabVIEW mérés file írása
• Tartalmazza a megnyitás, írás, lezárás és a hibakezelés 

funkcióit
• Kezeli a számformatálást és a tabulátor vagy vessző határolást
• A Merge Signals függvény segítségével adatok kombinálhatók 

egy dinamikus típussá



4. Gyakorlat – Adatgyűjtés és analízis
Hőmérséklet regisztráló: Logger.vi elkészítése



VI. rész – Tömb függvények és Grafikonok

• Egyszerű tömbfüggvények
• Grafikon használata
• Többszörös grafikon készítése



Tömb függvények – Alapok
Functions >> All functions>> ArrayFunctions >> All functions>> Array



Tömb függvények – Build Array



Grafikonok
• A Graph palettából a Kontrolok menűből
Controls>>All Controls>>Graphs

Waveform GraphWaveform Graph –– Hullámforma Hullámforma 
grafikon: adatsor ábrázolása az grafikon: adatsor ábrázolása az 
index függvényébenindex függvényében
Express XY GraphExpress XY Graph –– Egy tömb Egy tömb 
ábrázolása a másik függvényébenábrázolása a másik függvényében
Digital Waveform GraphDigital Waveform Graph –– Bináris Bináris 
adatok, bitek ábrázolásaadatok, bitek ábrázolása



Grafikonok

Jobbegérgomb kattintás, tulajdonságok választása 
Properties – Interaktív testreszabás



5. Gyakorlat – A hullámforma grafikon használata



VII. fejezet – Stringek, Clusterek, & Hibakezelés

• Strings : karakterláncok
• Cluster : Adatrekordok - vezetékkötegek
• Cluster Függvények
• Hibakezelés: Error I/O



Stringek - karakterláncok
• Egy string megjeleníthető és nem megjeleníthető karakterek 

sorozata (ASCII)
• Sokféle alkalmazás – üzenet megjelenítés, műszervezérlés, 

file I/O
• A String kontrol/indikátor-ok a Controls »Text Control or 

Text Indicator palettán találhatók



Clusters : Klaszterek

• Adatstruktúra, ami adatokat gyűjt egybe
• Az adatok különböző típusúak lehetnek
• Hasonló a C-beli struct konstrukcióhoz
• Az elemek vagy mind kontrolok vagy mind 
indikátorok lehetnek 

• Huzalokből képezett kábelnek gondolható



Cluster létrehozása
1. Egy Cluster keret 

Controls >> All Controls >> Array & Cluster
2. Objektumok a keretben



Cluster Függvények
• A Cluster alpalettán a Functions>>All functions

palettán belül
• Egy cluster terminálra jobbegérrel kattintva a 

gyorsmenűből is választható.

Bundle

(Terminal labels 
reflect data type)

Bundle By Name



Cluster függvények

Szétbontás

szétbontás név szerint

Szétbontott kluszter
a diagrammon



Error Clusters – Hiba klaszter
• A Hiba Klaszter tartalma:

–Boolean Jelzi a hiba bekövetkezését
–Integer A hibakód
–String Szöveges információ, amely azt a VI-t

azonosítja, ahol a hiba keletkezett



Hibakezelési technikák
• A hibainformáció átadódik a subVI-ok között
• Ha egy subVI-ban hiba lép fel, a következő subVI-ok nem 

a szokásos módon hajtódnak végre
• Az Error Cluster továbbítja a hiba kódját
• Autómatikus hibakezelés

error clusters



VIII. rész – Esetválasztó és Sorrendi
struktúrák, Formula csomópontok



Case Structures - Esetválasztás
• Helye: A Structures alpalettán a Functions palettában
• Körbezárt, vagy a struktúrába vont csomópontok
• Kártyacsomagként pakolva, csak egy eset látható

Functions >> Execution control



6. gyakorlat – Hiba klaszter és kezelése



Sequence Structures – Sorrendi struktúra
• Az Execution Control alpalettán a Functions palettában
• Egymásután hajtja végre a kereteket
• Jobbegér kattintással adható hozzá egy újabb keret



Formula Nodes - Formula csomópont
• A Structurák alpalettán
• Bonyolult egyenletek megvalósítása
• A változók a kereten hozhatók létre
• Kis és nagybetű különbözik a változónévben
• Minden utasítást pontosvessző (;) zár le.
• A súgó mutatja a használható függvényeket

Pontosvessző!



IX fejezet – Nyomtatás és Dokumentáció

• Nyomtatás a File Menüből nyomtatóra, HTML, vagy rtf
fájlba

• Grafikonok és előlapképek programozott nyomtatása
• VI-ok dokumentálása a VI Tuljajdonságok » 
Documentation Dialógussal

• Megjegyzések hozzádása szabad cimkékkel az 
előlapon és a diagramm ablakon



Nyomtatás
• File » Print… Sokféle nyomtatási lehetőség

– Választható az Ikon, előlap , Blokk Diagramm, VI Hierarcha, A
SubVI-ok, vagy a VI verziók listája

• Nyomtatás Panel.vi (Előlap programozott nyomtatása) 
– Functions » All Functions » Application Control

• Jelentés generálás és nyomtatás (Functions » Output » 
Report)



A VI-ok dokumentálása

• VI Properties » Documentation
– Leírás és súgó információ a VI-ról

• VI Properties » Revision History
– Változások nyomonkövetése a VI-ra

• Individual Controls » Description and Tip…
– Jobb kattintás a leírás és Tipp javításához a frontpanelen

• Cimkék használata a Frontpanel és a Diagramm 
megjegyzések készítésére



Section X – Alapvető program struktúrák

• Egyszerű VI konstrukció
• Általános VI konstrukció
• Állapotgép konstrukció



Egyszerű VI konstrukció

• Egyszerű VI ami a futtatáskor egy eredményt generál
– Nincs “start” vagy “stop” lehetőség
– Alkalmas egyszerű tesztre vagy számolásra

• Például: A C-ról F-re konvertáló vi



Általános VI konstrukció

• Három fő lépés
– Inicializálás
– Főprogram
– Lezárás



Állapotgép konstrukció
• Előnyök

– Bármely állapot lehet a következő
– Könnyű tesztelni és módisítani

• Hátrányok
– Kihagyhat eseményeket, ha egyidejűleg 

következnek be
Állapotok:
0: Startup
1: Idle
2: Event 1
3: Event 2
4: Shutdown



7. Gyakorlat – Egyszerű állapotgép



XI rész – Távol előlap

• Labview előlap megtekintése és vezérlése böngésző 
segítségével az interneten

• Nem kíván programozást
• A távoli kliens egy “élő” frissített előlapot lát
• Több kliens is nézheti ugyanazt az előlapot egyidejűleg
• Egyszerre csak egy kliens kezelheti az előlapot



Előlap publikálás távoli eléréshez
•Tools » Web Publishing Tool…

A lemezre mentésre 
kattintva a VI-t egy 
HTML be ágyazva 
menti el

A mentés során 
keletkezett fájl utólag 
megnyitható és 
bármely HTML 
szerkesztővel 
testreszabható



Távoli előlap - Információk

• NI Developer Zone 
(zone.ni.com)
– Keresés: Remote Front 

Panel
– Magyarázatok és Leírások 

letölthetők
– Információ Webkamera

beépítés lehetőségéről



XII rész – További témák

• Tulajdonság csomópontok
• Lokális változók
• Globális változók
• DataSockets - Adatcsatorna
• Bináris File I/O



A következő lépések?

• Mintaprogramok (Help» Find Examples…)
• LabVIEW Hallgatói változat (www.ni.com/labviewse)
• Web erőforrások (ni.com)

– NI Developer Zone (zone.ni.com)
– Alkalmazási példák leírásai 
– Info-labview hírcsoport (www.info-labview.org/)
– Eszköz vezérlő könyvtárak (www.ni.com/idnet)


